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SYSERR Utility - Overview

SYSERR Utility - Overview

When you develop a Natural application, you may want to separate error or information messages from your
Natural code and manage them separately. This makes it easy for you, for example, to standardize messages, to
s for different kinds of messages, to translate the messages into another language

have predefined message range

or to attach a long text to a message, which explains it in more detail.

With SYSERR, you can write your own application-specific messages. In addition, you can modify the texts of
the existing Natural system messages; this is not recommended, however, because with new Natural releases

these modifications will be lost.

Select any of the following topics:

@ |General Information on Message types and languages.
Messages

@ |Invoking SYSERR Starting the SYSERR utility.

& | SYSERR Window and SYSERR window elements and functions available for creating and
Functions maintaining messages.

& Converting Short Messages | Converting characters in message texts.

@ | Generating Message and Te Creating or recreating text files and generating message modules.
Files

& |User Exit USR0020P Reading messages from Natural system files.
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General Information on Messages

Message Types
Message Languages
Which Messages Do You Receive?

[ ]
[ ]
[
e Displaying Natural Long Messages

Message Types Texts

There are two types of messages:

® Natural system messages which are stored in the system file FNAT and which are not attached to libraries,
and

e User-defined messages which are stored in the system file FUSER or FNAT and which are attached to
libraries (including SYS-libraries).

There are four types of message texts which can be created and maintained with SYSERR:

® Natural (system) short message
e Natural (system) long message
® User-defined short message
® User-defined long message

A short message is the one-line message which is displayed in the message line when the corresponding error
situation occurs.

A long message is a detailed explanation of the corresponding short message. Bisplaisng Natural Long
Messages.

» To invoke a user-defined short message in a Natural program

® |ssue the statement "REINPUTRrNA', wherennnnis the number of the requested message.
Or issue the statement "INPUT WITH TEXTfrind' statement wherennnis the message number.
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Message Languages
Messages can be created in up to 60 languages.
The following rules and restrictions apply:

Natural short messages must be entered in English first, and can then be translated into any other language.
Natural long messages can be entered in English, but cannot be translated into other languages.
User-defined short messages can be entered in any language, and then translated to any other language.
User-defined long messages can be entered in any language, but only if the corresponding short message
already exists.

Which Messages Do You Receive?

Natural Short Messages

When a program issues a Natural short message, Natural looks for the requested message number on the system
file FNAT in the following order:

1. under the current language code as determined by the system variable *LANGUAGE,
2. under Language Code 1 (English).

If neither of the above is found, you only receive the message number prefixed with NAT, for example,
NAT0230.

User-defined Short Messages

When a program issues a user-defined short message, Natural first looks for the requested messagenumber
under the current language code as determined by the system varei@UAGE (see the Natural

Programming Reference documentation). If that message does not exist, Natural looks for the requested message
numbemnnnunder Language Code 1 (English). If that message does not exist either, Natural looks for message
numbemOO0O0 (wheren is the first digit of the requested message number) under Language Code 1.

These three search steps are first performed in the current library. If nothing is found there, further libraries are
searched in the same way until a corresponding message is found.

The sequence of libraries for the search is as follows:

1. the current library as determined by the system variable *LIBRARY-ID,

2. the steplibs; if Natural Security is installed, the sequence in which the steplibs are specified in the Natural
Security profile of the current library,

3. the default steplib as determined by the system variable *STEPLIB,

4. the library SYSTEM on the system file FUSER (*),

5. the library SYSTEM on the system file FNAT (*).

(*) If the name of the current library begins with SYS, SYSTEM FNAT is searched before SYSTEM FUSER.

Displaying Natural Long Messages

When you receive a Natural short message, you may be looking for further explanations regarding the problem
situation. Most of the short messages have corresponding long messages with additional information and
resolution instructions.
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If the current library does not contain a corresponding long message, the one contained in the library indicated
by *STEPLIB is displayed.

» To display the long message of the most recent Natural short message

® Choose Help from the Error dialog box.
Or enter the command "HEL#nNn"
Or enter the command ¥hnri'
wherennnnrepresents the message number of up to four digits.

See also the system command HELP as described in your Natural User’s Guide.

The language code of the long message displayed is the same as for the corresponding short message. If no long
message exists under that language code, the corresponding long message under Language Code 1 is displayed.
If such a long message does not exist either, no long message is displayed at all.
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Invoking SYSERR

This section describes alternative methods of invoking the SYSERR utility window for specified message files.
You may use either the SYSERR dialog box or select a message file from a Natural directory. Note that for
accessing Natural system messages you can only use the selection function of the SYSERR dialog box.

From the SYSERR window, you can invoke all functions available for message maintenance. The functions are
explained in the secticdBYSERR Window and Functions

» To invoke SYSERR via dialog box

e From the Natural View menu, choose Direct Command and, in the Command field, enter the system
command SYSERR.

Or, from the Natural Tools menu, choose Development Tools and Error Messages...

The SYSERR dialog box appears:

%] SYSERR Utility

Error Message

Maintenance
oK
: Cancel
Help

® Overwrite the library name or select a library from the Library drop-down list box and select a language
from the Language list box.

To access Natural system messages:
From the Library list box, select "<natsys>" or remove the library name and leave the box blank,
from the Language list box, select the standard language defined for your Natural environment.

® Choose OK to confirm your selection.
The SYSERR window is displayed.

» To invoke SYSERR directly from a directory

e From the Natural View menu, choose Library Workspace and click the Logical View button.
o From the Natural directory tree, select the library desired.

The message files are listed per language in the subdirectory Error Messages.
e In the subdirectory Error Messages, double-click a message file.

The SYSERR window is displayed.
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SYSERR Window and Functions

From the SYSERR window, you can invoke all commands and functions available for message maintenance:

%] 5YSERR - Uszer Messzages of Library TESTLIB in Englich

File Edit “iew DOptions Help

s@8 sme - HE H 2 e @rall
0001 Message number
0002 Message number
0003 Message mamber
0004 Message nunber
0005 Message nunber
0006 Mezsage number
0007 Message number
0005 Message number
0009 Message mamber
0010 Message mumber 10 Espl: |This iz message mmber 1
0011 Message number 11
0012 Message number 12
0013 Message number 13
0014 Message numbher 14
0015 Message mamber 15
0016 Message number 16
0017 Mezsage number 17
0015 Message number 15
0019 Message number 19
0020 Message numbher 20
0021 Message mamber 21
0022 Message number 22—
0023 Message number 23
0024 Mezsage mumber 24 Action: [No action
0025 Message number 25

DDFE HESjage runber 26 %
4 4

|Messagerange[1 - 9399 ] lizted fram 1 ta 9399 .

mnber 1

Erevinus | Mext I Mew | Shart to Lohg

Test: |Thisz iz the sample message for library TESTLIE

0 -1 om0

w

The window contains two panes. To modify the size of the window, move the mouse pointer over the right
border until two arrows point in opposite directions. Then, drag the border using the mouse until the window has
the desired size.

There are context menus available for several dialog elements. A context menu is displayed by right clicking the
dialog element. The available commands are either Cut and Paste functions or correspond to the commands in
the menu or to push buttons.

As an alternative to the menus and the push buttons, most of the SYSERR functions and commands can be
executed with the buttons of the toolbar.

This section covers the following topics:

Title Bar
Push Buttons
Menu Bar
Toolbar

List Box
Fields
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SYSERR Window and Functions Title Bar

Title Bar

The title bar displays the

® Message type
(Natural system or user-defined)

® Selected library
For Natural system messages, no library is displayed.

® Selected language
For more information, see the system varighlBNGUAGE in the Natural Programming Reference

documentation.

Push Buttons

The following commands can be executed using push buttons:

Command Explanation

Copy Only visible if a sample message exists. If activated, the text of the sample message is [copied
into theShortfield of the message. See also Fields below.

Previous / OK| Toggles between Previous and OK, depending on the status of the current message:

OK Saves the current message to the message file after modification.

Previous Scrolls from the current message to the previous message if no modification was
made.

Note: You can only save a message if text was entered iBhbdtext field. See also Fields
below.

Cancel / Next | Toggles between Cancel and Next, depending on the status of the current message:

Cancel Cancels modifications made to the current message and displays the original
message.

Next Scrolls from the current message to the next message if no modification was inade.

New Searches for the next free message number starting from the current message. Free mgans that
this message number is available and has not yet been assigned to a message file in ahy
language.

The direction of search is downwards by default, but depends on the last search specification
(perhaps upwards) executed with Mew Messageommand of the Edit menu.

Short to Long | Copies the text of the Short field to the first line of the Long Text field.

Menu Bar

The commands available with the SYSERR menu are described below. Some menu items are used to switch
between modes or set a status. The check mark next to a menu item indicates which mode or status is active.
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Menu Bar

Below is information on:

File Menu
Edit Menu
View Menu
Options Menu
Help Menu

SYSERR Window and Functions
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File Menu

Command | Explanation

New Selects a new library and/or a new language. A dialog prompts you for input.
Lib/Lang Only libraries and languages are displayed for which no message file exists.
After you have made your selection, an empty SYSERR window appears, in which you c@n enter
a new message.

Open Selects another library and/or another language. A dialog prompts you for input.
Lib/Lang Only libraries and languages are displayed for which messages already exist.
After you have made your selection, you can modify the existing messages or add new opes.

Open File | This function does not apply if you wish to access data on mainframe servers.

Selects an existing message file from the Natural file tree (FNAT, FUSER or Natural systém) or
from another directory.

See also the sectidviessage and Text Files

Print Invokes the print function.

A dialog box prompts you to enter the error numbers, mark the Long Text print-out option
specify layout parameters and select the output device (printer or source area). The initia
assignment is the default printer set by Windows.

See also howo print all Natural system messadesow.
Exit Exits SYSERR.

» To print all Natural system messages

1. Select library "<natsys>".
2. Select language English or German.
3. From the File menu, choose Print:
Specify the options provided, and leave the default values for the message range (1-9999).
4. Choose OK.
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Edit Menu

Edit Menu

SYSERR Window and Functions

Command

Explanation

Cut

Copy

Paste

Supported clipboard functions.

Undo

Delete

Standard edit functions.

New Message

Searches for the next free message number, for which no other message exists in any
language.
Upwards/Downwards: the next lower/higher message number from the current message.

Delete Selecte

Removes all messages selected (highlighted) in the list box. A dialog box prompts you|to
confirm the action.

Delete All

Removes all messages displayed in the list box. A dialog box prompts you to confirm the
action.

When all messages of a message file have been deleted, the message file is deleted tpo.

Read All

Reads all messages from a message file into the list box in one step. This command applies to
message files with more than 200 messages.

Otherwise, for performance reasons, only 200 messages are read by default when the
SYSERR window is started. Additional messages can be displayed scrolling down the Jist box
to the end or using the Read All command.

Translate

Supports the creation of error messages for different languages. Applies to short messpges
only. Se€To translate languagéslow.

10
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SYSERR Window and Functions Edit Menu

» To translate languages

1. From the Edit menu, choose Translate.
The Select Languages dialog box opens:

*J] Translate - Select Languages M= E3 |

Ok

Cancel

Help

2. Select one language or more into which you wish to translate the current message and choose OK.
3. Another dialog box opens:

% Translate - Short Message Number 1 of Library TESTLIBE
File Optionz  Help

F T = o T LT

Language I Short Text
(1) English Meszage rmamber 1
(2] German |
[3) French
(4] Spanish
EreviouE M et

Command/Fields |Explanation

Select Languages | Invokes the Select Languages item from of the Options menu to add additiona
(Options menu) | languages unless selected earlier, during Step 1 above.

Available The language code(s) of the language(s) already available for the current megsage
Languages number.

Language Code and language of the new language selected.

Short Text The text of the short message.

Previous/OK Same as described fBrevious/OKunder Push Buttons.

Cancel/Next Same as described f@ancel/Nexunder Push Buttons.

Help Display SYSERR help text.

4. Enter the translation in the Short Text field of the relevant language.

5. Choose OK.
The language code of the new language appears under Available Languages.

The language of the current short message (in the example above English) is always listed in the first position of
the translation dialog.
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View Menu SYSERR Window and Functions
View Menu

Command Explanation

Languages Enables/disables the Languages Display. The Languages Display gives an overview of all

Display available languages for one message number. Default is the Compressed display as dgscribed
below.

Compressed | Applies to the Languages Display command. Sempressethelow.

Extended Applies to the Languages Display command.

Short Enables/disables the code display of languages in which the short texts exist next to the error
number.

Extended Long Applies to the Languages Display command.

Enables/disables the code display of languages in which the long texts exist next to thg error
number.

Filter Display | Applies to the Set Filter function described un@leractivate the Set Filter function
Enables/disables the display of short messages that match the scan criteria defined as|filter
values in the Set Filter dialog box.

Set Filter Enables/disables the Set Filter function. Scans the short messages in conjunction with the Set
Filter search criteria and displays the results in the list boxT 8eetivate the Set Filter
function
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SYSERR Window and Functions View Menu

Compressed
The Compressed view displays the code(s) of the language(s) in which the message exists

® next to the message number for short texts, and
® next to the Long column for long texts.

"4 SYSERR - Uszer Messages of Library

File  Edit
J =k v Languages Display
v Comprezsed

Estended Short

Optionz  Help

oooz 1z  Extended Long
gggi iE Eilter [replay
oons 1 =etFilter.
0006 1 Lorneg:

o007 1 Lotg:

0008 1 Lorneg:

0o00% 1 Loneg:

0010 1 Lotg:

0011 1 Lone:

0012 1 Loreg:

0013 1 Lotg:

nol4 1245 Long:l
0015 1 Long:

00le 1 Lotg:

0017 1 Lotw:

In the above example the short text for message number 14 exists in English = 1, German = 2, Spanish = 4, and
Italian = 5. The long text for message number 14 exists in English = 1.
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¥ To activate the Set Filter function

1. From the View menu, choose Set Filter.
A dialog box prompts you to enter the scan criteria:

=4 Set Filter for Meszage List

Filter walues:
I]-JuffEr O oOr ¥ Find whole words
'y &n.j [T Case senzitive
IPDDl .........
I " Mot
I ok, Cancel Help |

The following options are provided:

Option Function
Filter Values There are four fields available to enter search criteria.
Or/And/Not You can include the conditional operands OR (default), AND or NOT between the

search items.

If you only fill one of the Filter Value fields, the conditional operands are ignorefl.

Find Whole Words By default, the scan is restricted to match entire words only and not parts of a §earch
string.

Case Sensitive | If marked, the scan is restricted to words in lower and upper case.

In the example above, the search would be for the short message which contains both the words "buffer"
and "pool". If the operand NOT were specified, then the search would find all messages which contain
neither the word "buffer" nor the word "pool”.

2. Enter the search criteria and choose OK.
The Set Filter function is enabled and the short messages matching the criteria are
displayed in the list box.

To deactivate the Set Filter function, disable Filter Display from the View menu.
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SYSERR Window and Functions Options Menu

Options Menu

mber of

g a

vas

Command | Explanation
Sample Creates a sample message to be used as a master for creating short messages. 108 gtring
has been entered in the sample message, when copied, the string is replaced by the nu
the new message.
You can define one sample message for each language.
Layout Seelayoutbelow.
Shift Short | If enabled, automatically shifts the text of a short message to the left margin when addi
Left new message or choosing OK after modification.
Size Startup Resizes the dialog to the size it had at startup.
Full List Box Resizes the dialog to display the short message in full length.
Confirm Enables/disables a pop-up window to confirm:
Window
® the new message number,
e that the short text is copied to the first line of the Long Text field if "Short to Long" |
chosen,
e that the Sample text is copied to the Short Text field if Copy was chosen.
Import Text | This function does not apply if you wish to access data on mainframe servers.
File

Imports a text file and converts it into a message file. Note that you always need to spedify the
full path of a file.

For further information on file formats and how to recreate a text fildylsssage and Text

Files

From The name of the text file from which the message file will be generatefl.
(text file)

To The name of the message file into which the text file will be generated.

(message file) Default is the full path name of the current library and message file.

For user-defined messages, the file name musnipdRMSL.MSG.
For Natural system messages, the file name mustberfinmnMSG.
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Options Menu SYSERR Window and Functions

Command Explanation

Export This function does not apply if you wish to access data on mainframe servers.
Message File
Exports a message file and converts it into a text file. Note that you always need to spegify the
full path of a file.

For further information on file formats and how to recreate a text fildylsssage and Text

Files

From The name of the message file, from which the text file will be

(message file) generated. Default is the full path name of the current library and mesgage
file.

For user-defined messages, the file name musnpdRMSL.MSG For
Natural system messages, the file name mustripne iMMnMSG.

To The name of the text file that will be generated.
(text file)
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SYSERR Window and Functions

Layout

Allows specification of valid message ranges to categorize messages. Overlapping of ranges is possible. A new

message can only be added if its number is within the range defined in the layout.

The layout definition applies @l languages. It is stored in the English message file.

To insert or delete rows, mark a row and press the insert or delete key. If the maximum of 18 rows is displayed,

you may have to delete or overwrite another row before you can insert a new one.

" Lapout - Maintain Lapout Definition of Library TESTLIB

Help Menu

] A |

Fram

Tao

Drezcription

oool

o]~

0025 Main Menu

a0z 0050  Subfunction 1
a5l 0100 | Subfunction =2

ok

Cancel

Help

Help Menu

Displays SYSERR help text.

Copyright © Software AG 2002

17



Toolbar

Toolbar

The toolbar buttons represent the following menu commands or push buttons:

YO PH SBIODE @F =< 0y

F2 > @ =

18

New Library/LanguagéFile menu)
Open Library/Languagéile menu)
Print (File menu)

Exit SYSERR (File menu)

Cut (Edit menu)

Copy (Edit menu)

Paste (Edit menu)

Undo (Edit menu)

New Message upwardEdit menu)
New Message downwardEdit menu)
Read All(Edit menu)
Translatg(Edit menu)

Filter Display(View menu)
Previous(push button)

Next (push button)

OK (push button)

Cancel(push button)
Sample(Options menu)

Layout (Options menu)

Size StartugfOptions menu)
Import Text File(Options menu)

Export Message FiléOptions menu)

SYSERR Window and Functions
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SYSERR Window and Functions List Box

List Box

The list box appears on the left side of the SYSERR window. It contains the short messages of one language for
one library. The short texts are preceded by the message number. The messages are sorted by the message
number in ascending order.

If a message file contains more than 200 messages, for performance reasons, not all messages are read in one
step. When initializing the SYSERR window, up to 200 messages are read from the message file at once, and
about 30 of them are displayed in the list box. Scrolling down the list with the vertical scroll bar, the next 200
messages are read and displayed as soon as the scroll bar reaches the bottom of the list box.

The commandRead Allas described in the section Menu Bar reads all remaining messages in one step.

The selected (highlighted) short message is the current message. It is displayed on the right side of the SYSERR
window. There, you can modify the short and long text. Sed~adadsbelow.

Fields

The following fields appear in the SYSERR window:

Field Explanation

Sam. Output field displaying the text of a sample message if created.

To create a sample message,Samplein the section Menu Bar.

17
o

Num. Modifiable field displaying the number of the current message. It corresponds to the select
message in the list box.

It is possible to select another message number or to insert a new one.
The maximum message number for a library is 9999. The message number 0000 is not allqwed.

Short Modifiable field displaying the short message text of the current message number.

If you enter.C, the sample message for the selected language and library is copied into this{field.
See als@amplein the Menu Bar section.

A new message can only be saved if text has been entered in the Short field. Therefore, if jo text is
displayed for the current message, the message number is free and can be assigned to a new
message.

Long Text Modifiable field displaying the long message text of the current message number.
It consists of three sections:

Long description
Explanation
Action

Copyright © Software AG 2002 19
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Converting Short Messages

If your terminal does not display certain characters correctly or if your terminal cannot display lower-case
characters, it is possible to convert the characters of Natural short messages with the SENSYS-D dialog.

» To convert characters of messages

1. From the SYSERR subdirectory Dialogs, select SENSYS-D.
Or select library SYSERR and enter command SENSYS-D.
The Functions for Natural Short Messages dialog box opens:

*J]SENSYS-D - Functions for Natural Short Messages M= E3

Function  Help

Eror range: I : I9999 Scan walue: Iﬁ

Lanquage: i Feplace walue: IDD

2. Specify the error message range and the Language.
If desired, enter hexadecimal values in the Scan Value and Replace Value fields.

3. From the Function menu, choose an item:

" SEN5Y5-D - Functions for HATURAL

Funiction
Uppercaze Messages
Scan Character Hex

Srcan and Replace
Beplace uzing SECSET-M

v Dizplay Mezzage Hexadecimal
v Dizplay Char Table far Terminal

Proceszing Log

Exit .3
igzingsinwalid syntax: undefine

A6 T IEE0 2667600627 TETET32T0006600
9339EYFREGLICA4039E4183B05SE4L569E5

B e e e T Tr T
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Converting Short Messages

Converting Short Messages

The following functions are provided:

Function Description
Uppercase Converts messages to upper case. Once converted to upper case, you cannot g
Messages them back to lower case. To recover lower-case messages, unload the error mg

using SYSTRANS, save the transfer file and, when required, reload the messag
using SYSTRANS. See also the NatuBAYSTRANS Utility documentation.

Scan Characters
Hex

Scans for hexadecimal characters entered in the Scan Value field.

Scan and Replag

Scans hexadecimal characters entered in the Scan Value and replaces them wi
hexadecimal characters entered in the Replace Value fields.
This function may, for example, be useful to replace special signs.

Replace using
SECSET-N

Replaces the characters of a message by the character set defined in the subpr
SECSET-N.
SECSET-N is stored in the SYSERR subdirectory Subprograms.

Display Message
Hexadecimal

Enables/disables the display of a message in hexadecimal format.

Display Char
Table for
Terminal

Enable/disable this function to determine the characters your terminal can repre|

onvert
ssages
les

h the

pgram

Sent.

Processing Log

Enable/disable the processing log to view the results of the executed functions.

Copyright © Software AG 2002
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Generating Message and Text Files

Message modules are created and maintained with the import and export functions of the SYSERR utility. They
are generated from text files and stored as message files with the file extension .MSG in operating system
directories.

The message files are located in the following Natural directories:

FUSER\<library>\ ERR
FNAT \<library>\ ERR
Natura\ERR

User-defined messages are stored in the subdirectory ERR of the library on the FNAT or FUSER system file
from which the application is executed, the steplib, or the library SYSTEM.

For Natural system messages, the message modules must be located in the subdirectory ERR in the Natural root
directory. Natural system messages are stored in eight message modules.

Below is information on:

® (Creating Text Files
® Generating a Message Module
® Recreating Text Files

Creating Text Files

For Natural system or user-defined messages, the import function of SYSERR generates a message module from
one text file.

To create such a text file, you must use a specific layout, as shown in the following example:

Example:

NAT

0010

0100

0010E NO MESSAGE TEXT DEFINED!

0020E MISSING/INVALID SYNTAX; UNDEFINED VARIABLE-NAME.

0025E ERROR IN ENTRY FOR NUMBER OF RECORDS TO BE PROCESSED.
0050E INCORRECT FIELD SPECIFICATION IN 'WHERE' CLAUSE.

#PLEASE CHECK PROGRAM

#FOR ERRORS

0100E FUNCTION NOT AVAILABLE.

Explanation:
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Generating Message and Text Files

Creating Text Files

NAT

Group ID (library name) and prefix for the number that will be displayed with the message. It caln have

up to eight characters.

0010

Four-digit starting number of the range of messages.

0100

Four-digit ending number of the range of messages. All error numbers that are defined in this t¢

must be within this range.

pxt file

0010E

NO MESSAGE TEXT DEFINED.

This is the message for error number 0010. Elie mandatory and means "error". This message W

be issued with the statement "REINPUT *0010".

Explanatory long texts must be placed immediately below this message; each of these addition

must start with a hash/number (#) sign. Up to 20 additional lines are allowed.

al lines

Copyright © Software AG 2002
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Generating Message Modules

Once the text files have been created, you can generate a message module from the text files with the SYSERR
utility.

For user-defined messages, one output error file can be created in one language for each library. Each error file
must be in the ERR subdirectory of that library.

Naming Conventions

For user-defined messages, the name of the message file must be:
NNnnAPMSL.MSG,

wherennis the language code (01 - 60), for example 01 for English.

For Natural system messages, the name of the message file must be:
NnnLmmmnmMSG,

wherennis the language code to be used mmmdmnmnthe starting number of the message range.
The ranges of message numbers are fixed, as defined during Natural system installation, for example:

NO1LO00O Messages 1 - 1999
NO1L2000 Messages 2000 - 2999

» To generate a message text file

® See thdmport Text Filefunction of the Options menu as described in the section SYSERR Window and
Functions.

Recreating Text Files

With the SYSERR utility, you can also recreate a text file for message text maintenance. This is done by
reconverting an error messages module into a sequential text file.

» To recreate a message text file

® See théexport Message Filkunction of the Options menu as described in the section SYSERR Window
and Functions.
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User Exit USR0020P

The user exit program USRO0020P in the library SYSEXT is provided to read messages from the FNAT or
FUSER system file. Thus, it is possible, for example, to have long messages displayed in an application (as part
of your own user-defined help system) without having to use the library SYSERR.

Log on to the library SYSEXT and enter the command MENU. On the list provided, mark the program
USRO0020P with a question mark (?); a window is displayed, on which you can select the function to be executed
for the program. If you enter dndetailed information on the use of USR0020P is displayed.
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